Flere scener

Fase

Abn en ny Flash File

Definér Stage
Farste scene
Ny scene

Navngiv

Forklaring

Abn Flash, veelg symbolet ud for Actions
Script 3.0

Séeet starrelsen
Lav indholdet af scene 1
Abn paletten Scene og veelg Add Scene

Dobbeltklik pa scenenavnet og omdeb

Navigationsseddel m m

Navigation

Create New

|® Flash File [ActionScript 3.00

SCENE

Tralala
Q &nkarnst
Q Bang

Q Hovsa
B Hvad s8¢
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Styr scener

Fase

Abn en ny Flash File
Definér Stage
Hent billeder

Navn
Placér billedet

Navn

Nyt lag

Knap
Tekst
Knap
Group
Duplikér
Ungroup

Skriv tekst

Justér

Flere scener

Navngiv knapperne

ActionScript

Forklaring

Abn Flash, veelg symbolet ud for Actions
Script 3.0
Saet starrelse til 550 x 350 px

Importér billederne fra mappen seasons i
kursusmaterialet

Navngiv det fgrste lag foto
Treek billedet spring ind pa Stage

Abn paletten Scene og navngiv scenen
spring

Opret et nyt lag, kald det knap

Tegn et grat rektangel, denne bliver til en
knap

Opert et nyt lag, kald det tekst. Skriv herpa
teksten Spring. Placér teksten ovenpa
knappen

Konvertér rektanglet til en Button (F8).
Navngiv den knap

Markeér tekst og knap og veelg group (ctrl+g)

Hold alttasten nede og traek tre dubletter
med musen

Veelg ctrl+shift+g for at lase de tre knapper
op igen

Skriv den rigtige tekst pa de tre knapper

Veelg Window > Align. Markér alle 4 knap-
per. Klik pa To Stage i Align paletten, Veelg
derefter Align Bottom Edge.

Marker de 4 knapper uden teksten, og veelg
Space evenly horizontally.

Markeér derefter de 4 tekstbokse og vaelg
igen Space evenly horizontally.

Duplikér scenen spring 3 gange og giv
scenerne de rigtige navne

Giv hver knap et unikt navn

Programmér alle scener. Se opgaven

Navigationsseddel m m

Navigation

Create New

|® Flash File [ActionScript 3.00

Convert to Symbol

Mame: | slidell

Type: |M|:uvie Clip [V]
= COLOR EFFECT

style: [ipha v
Mone

Alpha: Erightness %
Tink
Advanced

v Alpha
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Navigation

Fase

Abn en ny Flash File

Definér Stage
Tegn firkant

Konvertér

Redigér movieclippet

Nyt lag

Tegn elementer

Nyt lag
Navngiv lables
Navngiv movieclippet

Nyt lag

Knap

Duplikér knap

Navngiv knapper

Nyt lag

Nyt lag

ActionScript

Forklaring

Abn Flash, veelg symbolet ud for Actions
Script 3.0

Saet storrelse og baggrundsfarve

Tegn en firkant, red Stroke, intet fyld

Dobbeltklik pa stroken, konvertér til Mo-
vieclip med navnet indhold

Dobbeltklik pa movieclippet for at komme
til dets eget studie. Navngiv laget indhold.
Indseet frame i frame 4

Opret nyt lag, kald det grafik

Markér frame 2, indsaet Keyframe. Tegn en
firkant. Indseet Blank Keyframe i frame 3
og tegn en cirkel. Indseet Blank Keyframe i

frame 4 og tegn en trekant

Opret nyt lag, kald det /ables. Indsaet key-
frames i frame 2, 3 og 4

Frame 2 skal hedde firkant, frame 3 cirkel
og frame 4 trekant

Vend tilbage til Stage. Giv den store firkant
instance name: geometri_mc

Opret nyt lag, kald det knapper.

Tegn et rektangel, konvertér til Button med
navnet knap

Duplikér knappen 2 gange og placér dem
ovenover den store firkant

Giv knapperne instace names: firkant_btn,
cirkel_btn og trekant_btn

Opret et nyt lag, kald det tekst. Skriv tekst-
erne til knapperne. Placér teksterne ovenpa
knapperne

Opret nyt lag, kald det actions

Skriv ActionScriptet - se opgaven

Navigationsseddel m m

Navigation

Create New

|® Flash File [ActionScript 3.00

PROPERTIES

Ii Frame

=7 LABEL

Mame: |Firkank

TIMELINE

al

Al grafik o o [l olele
al indhold . » D -

O
@l actions « « O
ql tekst « « @
@l knapper + « W
al + O
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Billedgalleri1

Fase

Abn en ny Flash File

Definér Stage

Hent billeder
billede 1

Placér billederne

Opret lag
Knapper
Instance_name

Scripting

Forklaring

Abn Flash, veelg symbolet ud for Actions
Script 3.0

Saet starrelse og baggrundsfarve

Importér billederne fra mappen billedgalleri i
kursusmaterialet

Treek billede 1 over pa Stage. Konvertér
billedet til Symbol/Grafic

Markér frame 2 og indseet et tomt keyframe
(F7), treek billede 2 ind pa Stage. konvertér
igen til grafik og placér billedet i samme
position som billede 1 ved hjaelp af Align
panelet. Fortsaet samme fremgangsmade
med de 4 sidste billeder

Opret 2 lag. Kald det ene knapper og det
andet actions

Placér to knap-symboler (buttons) pa laget
du kaldte knapper.

Giv de to knapper navnene frem_btn og
tilbage_btn

I laget actions frame 1 tilfgjes ActionScript-
tet

Navigationsseddel m m

Navigation

Create New

|® Flash File [ActionScript 3.00

&, Seript Assist

POVvERRE UEYDPIME

stop():

function frem(event:MouseEvent) rvoid {
nextFrame () ;
i
frem bta.addEventListener (MouseEvent.CLICK, frem):

function tilbage (event:MouseEvent) :void {
prevFrame () ;
¥
tilbage_htn.addEventlistensr (HouseEvent.CLICK, tilbage]:
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Slideshow

Fase

Abn en ny Flash File

Definér Stage

Hent billeder

Lag

Placér billederne

Movieclips

Udvid filmen

Tween

Alpha

Dynamik

Forklaring

Abn Flash, veelg symbolet ud for Actions
Script 3.0
Saet storrelse og baggrundsfarve

Importér billederne fra mappen slide i kur-
susmaterialet

Opret 4 nye lag

Treek billederne ind pa Stage, placér dem
ved siden af hinanden, pa hvert sit lag
Konvertér billederne til Movieclips

Forleeng lagene til 70 frames. Indsaet Key-
frames i frame 35 og 70

Lav Classic Tween pa alle billederne

Markér frame 1 - slide1. Seet Alpha til 0%.
Markér frame 35, saet Alpha til 100%, mar-
kér frame 70, saet Alpha til 0%

Ryk de enkelte lags indhold pa Timeline.
Tilfgj evt. flere lag med halvtransparente
streger der bevaeger sig henover billederne

Navigationsseddel m m

Navigation

Create New

|® Flash File [ActionScript 3.00

Convert to Symbol

Mame: | slidell

Type: |M|:uvie Clip [V]
= COLOR EFFECT

style: [ipha v
Mone

Alpha: Erightness %
Tink
Advanced

v Alpha
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Masker

Fase

Abn en ny Flash File

Definér Stage
Lag
Tekst

Maske

Placering af firkanten

Bevaegelse

Masken

Las op

Stop

Forklaring

Abn Flash, veelg symbolet ud for Actions
Script 3.0

Saet storrelse og baggrundsfarve

Opret 2 lag

Skriv en tekst pa laget signatur

Tegn en firkant uden ramme pa laget ma-
ske. Firkanten skal veere sa stor, at den kan
kan daekke hele teksten

Indsaet en Keyframe i frame 40 (F6) pa
laget maske. | frame 1 placéres firkanten til
venstre for teksten, uden for Stage. | frame
40 placéres firkanten oven pa teksten, sa
denne er helt daekket

Veelg Classic Motion Tween

Hajreklik pa laget masken og veelg Mask
fra rullemenuen

Las lag og maske op ved at klikke pa haen-
gelasen ud for hvert lag

Indsaet en Stopaction i frame 40

Navigationsseddel m m

Navigation

Create New

|® Flash File [ActionScript 3.00
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Scrollbar

Fase

Kopier en tekst

Abn en Flash film

Foretag indstillinger

Opret tekstboks

Las tekstboksen

Indsaet tekst

Indsaet scroolbaren

Fastger scrollbaren

Tilret scrollbaren

Navngiv scrollbaren

Tilknyt scrollbaren

Forklaring

Abn mappen scroll fra kursusmaterialet,
abn filen tekst til scrollbar og kopier teksten

Behold default sterrelsen pa Stage

| properties veaelges Dynamic Text samt
udseeende af teksten

Treek en tekstboks pa Stage

Hajreklik pa tekstboksen med Selection
Tool

Indszet den kopierede tekst i tekstboksen

Hent scrollbaren | menuen Window. Veelg
Components > User Interfase. Veelg USI-
Scrollbar og treek scrollbaren ind pa Stage

Placér scrollbaren pa hgjre side af tekst-
boksen

Giv scrollbaren samme hgjde som tekstbok-
sen. Saet malene i Properties

Markér tekstboksen og giv den navnet
tekst_txtifeltet Instance Name i Properties

\
Markér scrollbaren og veelg Component
Inspector Panel i Properties. | feltet til hagjre
for scrollTargetName skriver du navnet du
gav tekstboksen, i dette eksempel tekst_txt

Navigationsseddel m m

Navigation

PROPERTIES

Text Tool

| Dynamic Text | =]

= CHARACTER =
[~]
=]

Family: | Verdana

Skyle: | Reqgular

N s Lo

ol

Tekst til scrollbar
Flashfilm er ofte meget visuelle,
de bestdr for det meste
avervejende af grafik, video og
billeder, og meget lidt tekst.
Hwis du gerne vil prassentere en
le=ngere tekst, og ikke gnsker
at bruge for meget af
skeermen, er det en lgsning, at
oprette et mindre tekstfelt, og
herpd satte en scrollbar,

|bekst_txk
[

[ Movie Clip

Component: LIScrollBar

COMPOMENT IMSPECTOR =

B UlscrolBar, stekst_txt>

Parameters | Bindings | Schemz
Marme Yalue
direction vertical
scrollTargetha. .. (tekst_txt
wisible true
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Import af lyd

Fase

Abn filmen bang.fla

Lag

Hent lyd

Komprimér

Forklaring

Abn filmen bang.fla fra mappen lyd i kursus-
materialet

Opret 1 nyt lag, kald det lyd

Veelg Window > Common Libraries >
Sounds. Treek lydfilen xplosion Blast
Large01.mp3ind pa Stage

Dobbeltklik pa lydfilen i Library. Test
forkellige komprimeringsgrader og
formater.

Navigationsseddel m m

Navigation

(o] e |

Duplicate windom

Toolbars
Timeline
IMotion Editor
Tools

v Properties

w Library
Zommon Libraries
Mation Presets

[P .

Sound Properties

Chrlal+k
3 ] 30
Chrl+Al+T
Chrl+F2
Chrl+F3
Chrl+L
3 Bukbons
Classes
Sounds

Compression: | MP3

Preprocessing:

Explosion Blast Large 01.mp3

C:\Program Filesiadobeladobe Flash
CS4\en\Configuration)sound
boothimp3tExplosion Blast Large 01.mp3
29, marts 2007 04:49:30

44 kHz Mona 16 Bit 7.4 s 654.1 kB

a3

Bit rate: |16 kbps

16 kbps Mono 14.8 kB, 2.3% of original

!!
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Lydafspiller

Fase

Abn en ny Flash File

Definér Stage
Knapper
Navngiv

Lag

Hent lyd

Forleeng og flyt

Lag

Programmér

Forklaring

Abn Flash, veelg symbolet ud for Actions
Script 3.0

Saet starrelsen til 100x50 px

Fremstil 2 knapper eller hent nogle forde-
finerede her: Window >Common Libraries

>Bottons

Giv knapperne instance names: play_btn
og stop_btn i Properties

Opret et nyt lag, kald det lyd

Treek lyden Foley Footstep Cowboy Boots
Running Between Surfaces 01.mp3 i Win-
dow >Common Libraries >Sounds ind pa

Stage

Forleeng begge lag til 60 frames. Flyt lyden
til frame 2

Opret et nyt lag, kald det actions

Abn scriptvinduet og skriv ActionScriptet

Navigationsseddel m m

Navigation

Create New

|® Flash File [ActionScript 3.00

TIMELINE | EUFPUT SEOMBPILE

= 8 0! 5 10

@] actions « o« @2
—

Q.J j . =] [=]

] knapper o o [Oie

TBvEER HEYDDOR
stopi):
play btn.addEventListener (HouseEvent.CLICK, playdound]:
atop_btn.addEventListener (HouseEvent.CLICK, stopSound]:

Y, Script A

function playSoundevent:MouseEvent): woid {
playi);

¥

function stoplSound(event:MouseEvent): void {
stopl):

1
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Klikbart banner

Fase

Abn en ny Flash File

Definér Stage

Hent billeder

Billede1
Navngiv lag
Forlaeng
Opret lag
Indseet tekst
Opret lag
Maske
Opret lag

Indsaet tekst

Opret lag

Fremstil knap

Indsaet knap

Instance_name
Opret lag
Scripting

Duplikér scener

Forklaring

Abn Flash, veelg symbolet ud for Actions
Script 3.0

Seet storrelse

Importér billedet fra mappen banner i kur-
susmaterialet

Treek billedet over pa Stage

Kald laget for baggrund

Forleeng filmen til 200 frames

Opret et nyt lag, kald det tekst1

Skriv eller kopier teksten til scene 1 linie 1
Opret et nyt lag, kald det maske1

Lav herpa en maske over 70 frames

Opret et nyt lag, kald det tekst2

Skriv tekstlinie 2 i frame 71, og lav ogsa et
lag med maske til denne tekst. Lad maske2
ga til frame 150

Opret et nyt lag, kald det link

Veelg Insert > New Symbol. Veelg Button og
kald den knap. Treek et rektangel pa 600 x
90 pixel pa knappens stage. Treek keyfra-

met fra Up og hen til Hit.

Vend tilbage til Stage og treek knappen ind
pa denne i laget link

Giv knappen Instance_Name: knap1_btn
Opret et nyt lag, kald det actions
Skriv scriptet til scene 1 (se opgaven)

Duplikér scene 1 to gange, og indsaet
ActionScript

Navigationsseddel m m

Navigation

Create New

|® Flash File [ActionScript 3.00

= @ O Up Ower Down| Hi
| j D =] 0 L

@ Scene 1

% Scenel
ﬁ acene 3

Duplicate Scene

10

I~

V)/|

Erhvervsskalern

1)

s Forlag



	nav_scener
	nav_styre
	nav_navigation
	nav_galleri
	nav_slide
	nav_masker
	nav_scroll
	nav_lyd
	nav_afspiller
	nav_banner



